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Welcome to RMC-TotalRisk 
The U.S. Army Corps of Engineers (USACE) Risk Management Center (RMC) developed the quantitative risk 
analysis software (RMC-TotalRisk) to enhance and expedite risk assessments within the USACE Flood Risk 
Management, Planning, and Dam and Levee Safety Communities of Practice. 

RMC-TotalRisk is a menu-driven software, which performs risk analysis from user defined hazard, system response, 
and consequence functions. The software features a fully integrated modelling platform, including a modern graphical 
user interface, data entry capabilities, and report quality charts and diagnostics. TotalRisk can perform multi-failure 
risk analysis for a single dam or levee or for a complex system with multiple components.  

Why you should use RMC-TotalRisk 
RMC-TotalRisk is a powerful risk analysis software package with an intuitive and easy to use interface. RMC-
TotalRisk reduces complexity in risk assessments by connecting the components of risk (hazard, response, and 
consequences) through an intuitive risk diagram. The software can generate various aspects of risk including 
Incremental, Background, Total, Failure, Non-Failure risk [1]. Every component of the software can be defined with 
uncertainty. The risk analysis supports modelling multiple locations each with their own failure modes as separate 
system components, making system level risk analysis easy. 

When should you use RMC-TotalRisk? Any time you perform a risk analysis, you can and should use RMC-TotalRisk. 
Typical applications in science and engineering include structural flood mitigation risk but can apply to any application 
that has a hazard and a consequence.  

Examples related to flood risk for dams and levees are provided throughout this document. However, the software is 
not limited to just flood risk management applications. RMC-TotalRisk is a general-purpose risk analysis software, 
capable of estimating risk for a variety of complex systems.  

System Requirements 
The RMC-TotalRisk program and all dependent libraries were developed using the .NET Framework 4.8. As such, the 
program is currently only available for the Microsoft Windows operating system. The recommended system 
configuration for RMC-TotalRisk includes: 

• 64-bit Windows Operating System (Windows 7 or newer) 

• 512MB of RAM at a minimum 

• 2GB of free disk space at a minimum 

• Quad-Core CPU with 2.7GHz (or faster) clock speed 

• 1280x1024 screen resolution or higher (and at least a 17" monitor) 

Installing RMC-TotalRisk 
RMC-TotalRisk version 1.0 is available as a portable package (.zip). Installing a portable package does not require 
administrative rights. Simply extract all contents of the portable package to the desired computer location. After 
extraction, the package contents will look as shown in Figure 1. Simply double-click the executable RMC-
TotalRisk.exe to get started. For easy access to the program, you can create a desktop shortcut and pin the program 
to your Windows taskbar.  

DRAFT



 
RMC-TotalRisk User Guide 

 

 

  
3 

 

   
Figure 1 –RMC-TotalRisk executable file in the RMC-TotalRisk portable .zip directory. 

Setting the File Association in Windows 
RMC-TotalRisk files have the “.tra” file extension. To have Windows automatically open .tra files with RMC-TotalRisk, 
first right-click a .tra project file. Select Open with… from the resulting menu.  

 
Figure 2 – Right-Click Menu for Project File in Windows. 

 

Then, from the menu that appears when you select Open with..., click Try an app on this PC for an expanded list of 
already installed applications. If you do not see RMC-TotalRisk, scroll to the bottom and select Look for another app 
on this PC. This will open a Windows Explorer dialog. Navigate to and select the executable RMC-TotalRisk.exe, 
then click Open. When you’ve found RMC-TotalRisk and it has been selected, check the box labeled Always use 
this app to open [.tra] files before you click the OK button. Now .tra files will appear in Windows Explorer with the 
RMC-TotalRisk icon. You can now double-click a project file to automatically open it with RMC-TotalRisk. 

 
Figure 3 – RMC-TotalRisk Project with File Association in Windows. 

Terms and Conditions for Use 
The United States Government, US Army Corps of Engineers, Risk Management Center ("RMC") grants to the user 
the rights to install RMC-TotalRisk "the Software" (either from a copy obtained from RMC, a distributor or another user 
or by downloading it from a network) and to use, copy and/or distribute copies of the Software to other users, subject 
to the following Terms and Conditions of Use: 
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All copies of the Software received or reproduced by or for user pursuant to the authority of this Terms and Conditions 
of Use will be and remain the property of RMC. User may reproduce and distribute the Software provided that the 
recipient agrees to the Terms and Conditions for Use noted herein. 

RMC is solely responsible for the content of the Software. The Software may not be modified, abridged, decompiled, 
disassembled, unobfuscated or reverse engineered. The user is solely responsible for the content, interactions, and 
effects of any and all amendments, if present, whether they be extension modules, language resource bundles, 
scripts or any other amendment. 

The name "RMC-TotalRisk" must not be used to endorse or promote products derived from the Software. Products 
derived from the Software may not be called "RMC-TotalRisk" nor may any part of the "RMC-TotalRisk" name appear 
within the name of derived products. No part of this Terms and Conditions for Use may be modified, deleted or 
obliterated from the Software. No part of the Software may be exported or re-exported in contravention of U.S. export 
laws or regulations. 

Waiver of Warranty 
THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES, AND 
EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE RMC-TOTALRISK "AS IS," 
WITHOUT ANY WARRANTY OR CONDITION, EXPRESS, IMPLIED OR STATUTORY, AND SPECIFICALLY 
DISCLAIM ANY IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NON-INFRINGEMENT. Depending on state law, the foregoing disclaimer may not apply to you, and 
you may also have other legal rights that vary from state to state. 

Limitation of Liability 
IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, BE LIABLE FOR 
LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR IN 
CONNECTION WITH USE OF RMC-TOTALRISK REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE. 

THE UNITED STATES GOVERNMENT’S LIABILITY, AND THE LIABILITY OF ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS, TO YOU OR ANY 
THIRD PARTIES IN ANY CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES OF 
RMC-TOTALRISK WITH IDENTIFIED ERRORS CORRECTED. Depending on state law, the above limitation or 
exclusion may not apply to you. 

Indemnity 
As a voluntary user of RMC-TotalRisk you agree to indemnify and hold the United States Government, and its 
agencies, officials, representatives, and employees, including its contractors and suppliers, harmless from any claim 
or demand, including reasonable attorneys' fees, made by any third party due to or arising out of your use of RMC-
TotalRisk or breach of this Agreement or your violation of any law or the rights of a third party. 

Assent 
By using this program you voluntarily accept these terms and conditions. If you do not agree to these terms and 
conditions, uninstall the program and return any program materials to RMC (If you downloaded the program and do 
not have disk media, please delete all copies, and cease using the program).  
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Graphical User Interface 
RMC-TotalRisk is a menu-driven software package that performs risk analyses. The software features a fully 
integrated modeling platform, including a modern graphical user interface, data entry capabilities, multi-failure risk 
analysis, and report quality charts. 

The graphical user interface consists of a Menu Bar, Tool Bar, and four window panes (Figure 4). The panes will be 
referred to as the Project Explorer, the Tabbed Documents, the Properties, and the Message Window. You may 
move, dock, hide, or close the window panes as desired. 

 
Figure 4 – RMC-TotalRisk User Interface. 
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Menu Bar 
The menu bar located at the top of the window, as shown in Figure 5, contains important commands needed for 
working with RMC-TotalRisk.  

 
Figure 5 – RMC-TotalRisk Menu Bar. 

 

File 
The File menu provides essential file management functionality. From this menu, you may create a new project, open 
an existing project, save or save as, open recent projects, or exit the application.  

 
Figure 6 – File Menu. 

 

If this is the first time you're using RMC-TotalRisk, your recent projects list will be empty. Once you have exceeded 
the number of projects shown in the recent project list (the default is 10), a menu item labeled as More Files… will be 
available. After clicking this item, a Recent Files dialog will open showing all available recent project files (Figure 7). 
From here, you may open any recently used project file, or clear the recent project file list.  
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Figure 7 – Recent File Dialog. 

 

View 
You may move, dock, hide, or close the Project Explorer, Properties Window, and Message Window as desired. 
The View menu allows you to unhide or open these windows. In addition, you can restore the default layout of the 
window panes.  

 
Figure 8 – View Menu. 

Project 
The Project menu contains commands related to the project you are working in. From this menu, you can create a 
new hazard, transform, system response, or consequence function. You can also add a new Risk Analysis. In 
addition, you can edit the project properties through the Properties Window. 

 
Figure 9 – Project Menu. 
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Tools 
The Tools menu provides tools for managing your project and personalizing your workspace. 

 
Figure 10 – Tools Menu. 

• Compact & Optimize Project File This option will compact and optimize the project database removing 
unnecessary tables. Using this tool can significantly reduce the size of your file without losing any project 
data. 

• Zip Project File This option will zip your project file and prompt you to save the .zip to a location on your 
computer. The zip file will be much smaller and can then be easily shared with others. 

• Restore From Backup restores the project from the backup file (***.tra.bak). A backup file is created every 
30 minutes by default, you can change the duration between backups in the Options dialog, File 
Management tab. 

• Equivalent Annual Consequences With this tool (Figure 11) equivalent annual consequences (EqAD) 
between two risk analyses can be calculated. EqAD is required in USACE planning NED cost evaluation 
procedures [2]. To calculate, define the analysis period in years and a discount rate as percent then select 
current and future risk analyses and the year those results represent. The EqAD will be automatically 
calculated. Use the table tools to add and remove EqAD calculations. You can also manually enter Base and 
Future Plan results by clicking in the dropdowns and typing the value. 

• Batch Run With this tool (Figure 12) you can simulate multiple risk analyses as a batch process. Batch 
processing can be very useful when inputs have been changed that are common across multiple risk 
analyses. 

• Options This tool allows the user to personalize their workspace. The user can customize the Application, 
File Management, Message Window, and Default settings. See the Personalize RMC-TotalRisk section below 
for more details. DRAFT
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Figure 11 – Equivalent Annual Consequences Tool. 

 

 
Figure 12 – Batch Run Risk Analyses Tool. 
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Window 
The Window menu allows you to close or activate the document windows. The active document will have a check 
mark next to it as shown in Figure 13. You can see all open windows by clicking Windows…, which will open a 
Windows dialog. From here, you can activate or save specific documents. In addition, you can select and close 
multiple documents at once.  

 
Figure 13 – Windows Menu. 

 

 
Figure 14 – Windows Dialog. 

 

Help 
From the Help menu, you can access this User Guide, view the Terms & Conditions for Use, or view the About 
RMC-TotalRisk splash screen.  

 
Figure 15 – Help Menu. 
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Figure 16 – About RMC-TotalRisk Splash Screen. 

Tool Bar 
The Tool Bar is located on the main window, below the Menu Bar. The buttons on the tool bar provide frequently 
used options under the File menu: 

• New Project 

• Open Project 

• Save Project 

 

 
Figure 17 – RMC-TotalRisk Tool Bar. 
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Window Layout 
In RMC-TotalRisk, you can customize the position, size, and behavior of windows to create window layouts that work 
best for you. When you customize the layout, RMC-TotalRisk will remember the configuration. For example, if you 
change the docking location of the Project Explorer and then close RMC-TotalRisk, the next time that you open the 
software, the Project Explorer will be docked in that same location.  

Types of Windows 
The RMC-TotalRisk layout is made up of four basic window types: the Project Explorer, Tabbed Documents, 
Properties, and Message Window (Figure 4). Document tabs provide the editing and reviewing space for the various 
project components including hazard, response, and consequence functions. The windows can be resized and 
dragged by their title bar, the document windows can be dragged by their tab. On the Project Explorer, Properties, 
and Message Window title bar, there is a drop-down with other window options.  

 
Figure 18 – Tools Window Options. 

 

With the tabbed documents, you can right-click on the document tab to set other options on the window. These 
options include docking, floating, and hiding windows.  

 
Figure 19 – Document Window Options. 

  
DRAFT



 
RMC-TotalRisk User Guide 

 

 

  
13 

 

Tab Groups 
The tabbed documents can be grouped together to enhance your ability to manage a limited workspace while you are 
working with two or more open documents in RMC-TotalRisk. You can organize multiple document windows and tool 
windows into either vertical or horizontal tab groups or move documents from one group to another. The windows and 
tab groups can also be floated and moved to different monitors. When you need to view or edit two documents at 
once, you can split windows by creating two horizontal tab groups as shown below in Figure 20. 

 
Figure 20 – Split Document Windows.  

Arrange and Dock Windows 
A document window can be docked, so that it will be in the Tabbed Documents area, or the document can be floated 
as a separate window independent of the main window. You can arrange windows in the following ways: 

• Dock tool windows to the edge of the main window frame.  

• Float tool and document windows over or outside the main window.  

• Hide tool windows along the edge of the main window.  

• Display windows on different monitors. 

• Reset window placement to the default layout by choosing View > Reset Default Layout.  

 
Arrange windows by dragging or right-clicking the title bar or tab of the window to be arranged.  
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Dock Windows 
When you click and drag the title bar of a tool window, or the tab of a document window, a cross shaped window 
placement guide will appear. During the drag operation, when the mouse cursor is over one of the arrows in the guide, 
a shaded area will appear that shows you where the window will be docked if you release the mouse button. An 
example of the window placement guide is shown below in Figure 21 and Figure 22. 

 
Figure 21 – Moving and Docking Document Windows.  

 

Figure 22 shows the Properties Windows being docked below the Project Explorer. The new location is 
demarcated by the light blue shared area. 

 
Figure 22 – Example of Docking the Properties Window Below the Project Explorer.  
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Close and Auto-Hide Tool Windows 
You can close a tool window by clicking on the X in the upper right of the title bar. To reopen the tool window, 
navigate to the View menu and select the desired tool window to show. Tool windows have an auto-hide feature, 
which causes a window to slide out of the way when you use a different window. When a window is auto-hidden, the 
window name appears on the tab at the edge of the main window as shown in Figure 23. To show the window again, 
move your mouse cursor over the tab so that the window slides back into view.  

 
Figure 23 – Auto-Hide Tool Window.  
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Project Explorer 
The Project Explorer, which is typically on the left-hand side of the main window, shows a graphical representation of 
the hierarchy of elements within your project. After you create a new project, you can use the Project Explorer to 
view, navigate, and manage the project elements.  

 
Figure 24 – Project Explorer. 

 

Project elements are organized under the Hazards, Transforms, System Responses, Consequences, and Risk 
Analyses folder headers. Many menu commands are available from the right-click menu on various items in the 
Project Explorer. You can create new elements, create groups, or sort the items in each folder, by right-clicking the 
folder icon or name. 
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Figure 25 – Project Explorer Element Collection Header Right-Click Menu. 

 

When right-clicking an individual project element, the following commands are made available: group, edit, copy, 
rename, delete, move up, and move down. When multiple project elements are selected, three right-click menu 
commands are available: group, edit, and delete. Double-clicking a project element will open it for editing. 

 
Figure 26 – Project Explorer Element Right-Click Menu. Options change when more than one item is selected. 

 

You can move individual project elements by left-click-hold and dragging the element. A horizontal line indicates 
where the element will be moved, as shown in Figure 27. You can also drag and drop input data from one RMC-
TotalRisk project to another. 
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Figure 27 – Project Explorer Element Drag and Drop. 

 

Grouping provides a way to manage the project explorer by consolidating project elements into sub-groups. When 
right-clicking a group element, all commands from the root folder are available plus Ungroup and Rename. 

 

Figure 28. Project Explorer Group Element. 
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Tabbed Documents 
In RMC-TotalRisk, document windows contain the project element data, such as input tabular data, event trees, and 
risk analyses. When you open a project element for editing, it will automatically open into the tabbed document group, 
which is typically located in the center of the main window (see Figure 29). You can reorder the tabbed documents, 
drag, or float them outside of the main window. When you click on, or activate, a document window, the associated 
project element properties will be shown in the Properties Window.  

 
Figure 29 – Tabbed Document Group. 
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Properties Window 
The Properties Window, typically on the right-hand side of the main window, displays the properties for the project 
and selected project elements. To access the element properties, open the element for edit (Figure 26). Some 
properties are common among all project elements, such as Name and Description, while others are unique to the 
specific elements. Properties are organized into groups for easier navigation. When you click on a property, the 
property description will be placed at the bottom of the properties window as shown in Figure 30. All analyses will be 
run from the properties window.  

 
Figure 30 – Properties Window. 
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Message Window 
The Message Window shows you errors, warnings, messages, and event logs regarding the current state of your 
project. If there are any errors in your project file, they are listed here. The Message Window lets you perform the 
following tasks: 

• Display the errors, warnings, messages, and events produced while you work in RMC-TotalRisk.  

• Double-click any error message entry to open the project element where the problem occurs.  

• Filter the type of entries that are displayed in the Message Window. The default is to only display errors and 
warnings. 

• Export all entries to a text file.  

 
Once you resolve an error, warning, or message, the entry will be removed from the Message Window. You may 
customize the font color of the various message types by navigating to Tools > Options. See the Personalize RMC-
TotalRisk section for more details. 

 
Figure 31 – Message Window. 
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Personalize RMC-TotalRisk 
You can personalize RMC-TotalRisk in various ways to enhance the user experience by navigating to Tools > 
Options. The Options dialog allows the user to customize the Application, File Management, Message Window, and 
Default settings.  

Application Options 
You can set the application color theme to be the Light or Blue theme as shown in Figure 32 and Figure 33. The 
default is set to the Light theme. You can choose to Save the window docking layout on close so that RMC-
TotalRisk will remember it when you reopen the application. You can also set the number of window items shown in 
the Window menu and the number of recent project items shown in the Recent Project list under the File menu.  

 
Figure 32 – Options Dialog with Light Color Theme.  

 

 
Figure 33 – Options Dialog with Blue Color Theme.  

DRAFT



 
RMC-TotalRisk User Guide 

 

 

  
23 

 

File Management Options 
RMC-TotalRisk project files are saved as SQLite databases. SQLite is a self-contained, high-reliability, SQL database 
engine, which is also one of the most used database engine in the world (https://www.sqlite.org/). Database files can 
grow quickly as you use them, sometimes hindering performance. They can also occasionally become corrupt or 
damaged. You can use the Tools > Compact & Optimize Project File command to prevent or fix these problems. 
You can also set RMC-TotalRisk to Compact & optimize project file on close.  

You can set the time interval in which a project backup file is created. A file with the extension .bak is automatically 
created when a project is opened. If the project closes successfully, then the .bak file is deleted. The database file can 
be damaged or corrupted, or the system could close unexpectedly causing you to lose important data, so on 
occasion, you might need to restore the project from a backup file by selecting Tools > Restore from Backup.  

 
Figure 34 – File Management Options.  
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Message Window Options 
You can adjust the auditory and visual setting for the Message Window. You can choose to turn on or off the beep 
sound effect and select the font color for the different message types, as shown below in Figure 35. 

 
Figure 35 – Message Window Options.  

 

Default Options 
You can set the default project location directory, and the default decimal digits for the project inputs and outputs 
(Figure 36 below). In addition, the default hazard type and units can be set for each input function category in 
TotalRisk. For example, by default, when you create a new hazard function, the hazard type and unit will automatically 
be set to Stage and ft, respectively.   

If the desired hazard type or unit is missing, click the  button to add a new option, if you want to delete an option, 
click the  button that appears inside the dropdown. 
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Figure 36 – Default Options.  
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Plot Features 
RMC-TotalRisk has plot features which allow you to examine and customize the plots. There is a tool bar located to 
the right of each plot, which allows you to interact with the plot in the following ways:  

 
Figure 37 – RMC-TotalRisk Plot Features.  

 Track Data 
Track Data to get the X-Y point values (Figure 38). Click on any plotted point or line in the graph to show a tooltip 
displaying the plot series name and X and Y data points. 

  
Figure 38 – Track Data on Plot.  

 Pan 
Pan/move the plot area by click-hold-dragging on the graph. The plot can be panned in any direction, up, down, and 
side to side. You can also Pan by click-hold-dragging the middle mouse button. 

 Zoom In 
Zoom in on the plot. Zooming works by click-hold-drag highlighting the area of interest with the magnifying glass 
cursor (Figure 39), or by click-hold-dragging on an axis to restrict zooming to only that axis. You can also zoom in and 
out using the mouse wheel. 

  
Figure 39 – Zoom In on Plot. 

 Zoom Out  
Zoom out to the plot extents. You can also hit the escape key to zoom out to plot extents. 

Add Annotations 
Add annotations to the plot (Figure 40). Annotations are elements of the plot that show information that is not part of a 
plot series. Annotations are not included in the legend and not used by the tracker. You may add the following 
annotation types to the plot: Arrow, Text, Vertical Line, Horizontal Line, Rectangle, Ellipse, Point, Polygon, and 
Polyline. 
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Figure 40 – Plot Annotations. 

 
The annotations can be moved by clicking and dragging them to a new spot. An example of an arrow and horizontal 
line annotation is shown in Figure 41. 

 
Figure 41 – Example of Arrow Annotation. 

 Save 
Save the plot image as a PNG, PDF, or SVG file. Select from common image sizes or define your own. 

  
Figure 42 – Set the Width and Height of the Plot Image. 

 Export 
Export plot series data to a Comma Separate (.csv), Excel (.xlsx), or SQLite (.sqlite) file. After clicking the Export 
Series Data button, a Save As dialog will open. Select the desired file type and give the file a name, then click save. If 
saving to an existing excel file, the plot series data will be saved as tabs in the existing file. 

 Plot Properties 
Plot Properties to customize appearance. In properties, you can edit the general plot settings, legend, axes, series, 
and annotations. Click the chevron  in the upper right to open a drop down showing the other plot elements to edit. 
Changes to plots in RMC-TotalRisk are saved and persist when you open and close a project.  
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Figure 43 – Plot Properties. 

Table Features 
Several tables in RMC-TotalRisk contain the Add and Remove Row Tools, the Export and Copy Tools, and the 
Row Selection Tools toolbars.  

Table Add/Insert/Remove Row Tools 
 

 Add Row 

This tool adds a row to the bottom of the table.  

 Insert Row  

This tool inserts a row above the selected cell(s). 

 Delete Row 

This tool deletes the row(s) of the selected cell(s). 
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Table Export and Copy Tools 
 

 Select All Cells 

This tool selects all cells in the table.  

 Copy Selected Cells  

This tool copies cells selected in the table. The information is copied to the clipboard and needs to be pasted 
to another application (e.g., Microsoft Excel®) for saving. 

 Copy Selected Cells with Table Headers 

This tool copies cells selected in the table and the table headers. The information is copied to the clipboard 
and needs to be pasted to another application (e.g., Microsoft Excel®) for saving. 

 Paste from Clipboard into Table 

This tool pastes data copied from another table into the current table.  

 Export Table 

The Export Table tool opens a Save As browser window, which allows the user to export the data in the table 
to other formats including Microsoft Excel® (*.xlsx) file. Note, if an existing excel file is selected, it will add the 
table to the existing file as a new tab. 

Table Row Selection Tools 
 

 Select Rows By Attribute 

This tool opens the Select By Attribute dialog box (Figure 44), which allows the user to perform queries, make 
selections, and locate features in the table.  

  
Figure 44 – Select By Attribute Dialog. 

 Show All Rows 

This tool allows the user to display all rows (selected or unselected) in the table. 

 Show Selected Rows Only 
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This tool allows the user to only display rows selected in the table.  

 Deselect All Rows 

This tool unselects all rows in the table. 

Table Column Features 
RMC-TotalRisk table columns can be sorted, searched, and when numeric they can have summary statistics 
generated (Figure 45). Sorting can be done by right-clicking on a column header and selecting the desired sort option 
or double clicking on the column header to sort.  Note, double clicking a column header that is already sorted will sort 
in the opposite order.  

 
Figure 45 – Table column header right-click options. 

 

Viewing summary statistics can be a very useful tool to view the data in a column. Note that you can check the 
Selected Rows Only checkbox to get summary statistics for only selected rows (e.g. rows where “SRP” is greater than 
the 25th percentile). 
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Figure 46 – Table Column Summary Statistics Dialog. 
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Working with RMC-TotalRisk 
In this guide, we will demonstrate how to create a project, enter hazard, transform, response, and consequence 
functions, set up a risk diagram, perform a risk analysis, and review results.  

Create a Project 
When you open RMC-TotalRisk, a Blank Project file is automatically created, as shown in Figure 47. The blank 
project is stored in your local temp directory. You may begin working with the blank project file immediately. 

 
Figure 47 – RMC-TotalRisk Blank Project. 

 

To save changes to the blank project, click the Save button on the tool bar or under the File menu. This will open the 
Save Project As… prompt. Enter the desired file name and click the save button in the bottom right. Now you are 
ready to continue working with RMC-TotalRisk. 

 
Figure 48 – Save Project As…. 
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A new project can also be created by clicking New Project… under the File menu, or by clicking the New Project 
button located on the tool bar as shown in Figure 49 and Figure 50. If this is the first time you're using RMC-TotalRisk, 
your recent projects list will be empty.  

 
Figure 49 – Create New Project from the File Menu. 

 

 
Figure 50 – Create New Project from the Tool Bar. 

 

The project properties will be shown in the Properties Window, which is typically located on the right-hand side of the 
main window. You may edit the project name and description.  
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Figure 51 – Project Properties. 

 

Overview of the Risk Analysis Framework 
In RMC-TotalRisk, a risk analysis computes the risk associated with a collection of potential failure modes for each 
component in the system. A failure mode is composed of a hazard, the system response to the hazard, and the 
consequences given the response to the hazard. A non-failure mode is composed of a hazard and the non-failure 
consequences given the hazard. 

The conceptual risk analysis process for a levee with a single failure mode and a single system component is shown 
in Figure 52 below. Beginning in the top left of the figure, the flood hazard is defined by an annual maximum peak 
flow-frequency distribution that is estimated using flood-frequency analysis methods. Next, moving to the top right, 
peak flow is then transformed to a WSE using a stage-discharge rating curve, which is estimated using a hydraulic 
model. Then, moving to the bottom right, the system response function is defined by a probability of failure given 
WSE, often derived from engineering analysis and expert elicitation methods. And finally, moving to the bottom left, 
the consequences given failure are estimated as a function of WSE. The expected annual consequences are 
computed by numerically integrating over these functions following Figure 52. Greater details on the mathematics of 
risk analysis are provided in the technical reference [1]. Additional details on risk analysis for flood risk management 
can be found in [3] and [4]. 

Figure 52 illustrates the key inputs for a single failure mode for a single system component. Starting from the top left 
of Figure 52 and moving clockwise, the key inputs are as follows: 

• Hazard Function: A hazard function describes the exceedance probabilities of various hazard levels. Hazard 
functions are also commonly referred to as frequency curves. Examples include annual maximum peak flow-
frequency, peak reservoir pool stage-frequency, and peak ground acceleration.  
 

• Transform Function: A transform function can be used to transform (or convert) the hazard levels from one 
type of function to another. For example, a peak flow-frequency function can be transformed to a stage-
frequency function using a flow-to-stage rating curve. Transform functions are optional inputs in TotalRisk. 
 

• System Response Function: A system response function describes the conditional probability of failure for 
various hazard levels, such as water surface elevations. System response functions are sometimes referred 
to as fragility curves. The system response function defines the failure mode in RMC-TotalRisk.  
 

• Consequence Function: A consequence function describes the consequences of failure or non-failure for 
various hazard levels, such as annual maximum peak water surface elevations. Consequence functions are 
also sometimes referred to as damage functions. 
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Figure 52 - Levee risk analysis process for a single failure mode and a single system component. 

 

The following chapters describe the hazard, transform, response, and consequence function options available in 
RMC-TotalRisk.   DRAFT
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Hazard Functions 
In RMC-TotalRisk, a hazard function is defined by the exceedance probabilities of various hazard levels, such as 
annual maximum peak flow or water surface elevation. Hazard functions are also commonly referred to as frequency 
curves. In the risk assessment of dams and levees, the annual maximum peak water surface elevation (or stage) or 
the annual maximum peak ground acceleration are typically the primary hazard parameters for evaluating a potential 
failure mode [3] [5]. As such, the hazard functions will commonly describe the annual exceedance probability (AEP) of 
these hazard levels.  

There are 6 options for adding a hazard function to RMC-TotalRisk: Import from RMC-BestFit, import from RMC-RFA, 
Parametric, Nonparametric, Tabular, and Composite. The following sections detail each option for adding hazard 
functions to RMC-TotalRisk. 

RMC-BestFit 
The USACE RMC, in collaboration with the Engineer Research and Development Center (ERDC) Coastal and 
Hydraulics Laboratory (CHL), developed the Bayesian estimation and fitting software (RMC-BestFit) to enhance and 
expedite flood hazard assessments within the Flood Risk Management, Planning, and Dam and Levee Safety 
communities of practice [6]. RMC-BestFit can be downloaded from https://www.rmc.usace.army.mil/Software/RMC-
BestFit/. Results from an RMC-BestFit analysis can be imported directly into RMC-TotalRisk.  

To import results of an RMC-BestFit analysis, right-click on the Hazards folder in Project Explorer (Figure 53) or 
from the Project MenuHazards and select Add RMC-BestFit Hazard…. A dialog will appear where you enter the 
name of the hazard function, select the RMC-BestFit project file, and select the Bayesian analysis from the project 
that you would like to import.  

 
Figure 53 – Add RMC-BestFit hazard function option and RMC-BestFit import dialog. 

Once satisfied with the import settings, click OK (Figure 53) and the RMC-BestFit hazard function will be added to the 
Hazards folder in Project Explorer, the function will be automatically opened into the Tabbed Documents area, and 
the input data properties will be displayed in the Properties Window. From here, you can set the Name, 
Description, Hazard Type and Hazard Units.  

When you create the new RMC-BestFit hazard function, the Hazard Type and Units will automatically be set to 
Stage and ft, respectively. The default hazard type and units can be changed by navigating to Tools > Options > 
Defaults. See the Default Options section for more details.  

The Hazard Type and Units can also be defined using the dropdown menus in the Properties Window (Figure 54). 
If the desired hazard type or unit is missing, click the  button to add a new option, if you want to delete an option, 
click the  button. Once the Hazard Type and Hazard Units have been defined, the hazard function is ready to be 
used.  
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Figure 54 – RMC-BestFit hazard function properties window. 

 

The Tabbed Document contains three tabs: Graphical Results, Tabular Results, and Parameter Sets. RMC-
TotalRisk provides several tools for exploring the results of the Bayesian analysis. The results will open to the 
Graphical Results tab by default as shown in Figure 55.  

 

Frequency Results 
The posterior predictive (mean), posterior mode, and Bayesian credible intervals (90% confidence) will be plotted on 
the Graphical Results tab. For consistency with other hazard function options, these are labeled as mean, computed, 
and confidence intervals, respectively. By default, the hazard function is plotted as a frequency curve, with 
exceedance probabilities plotted on the X-axis using a Normal scale, and magnitude on the Y-axis using a logarithmic 
scale. You may edit the plot properties, flip the axes, or change the axes scales as desired. RMC-TotalRisk will save 
and persist all changes you have made to the plot.  DRAFT
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Figure 55 – Graphical Frequency Results. 

 

Click the Tabular Results tab to view the frequency curve results and the posterior mode summary statistics as 
shown in Figure 56. All output posterior parameter sets are available on the Parameter Sets tab as shown in Figure 
57. You may sort these tables, copy, or export all values for external use. It can also be useful to generate summary 
statistics on the parameter sets column, such as the Mean (of log) (µ) column shown in Figure 58. 
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Figure 56 – Tabular Frequency Results. 

 

 
Figure 57 – Parameter Set Results. 
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Figure 58 – Summary statistics on parameter sets for Mean (of log) (µ). 

 

RMC-RFA 
The USACE RMC developed the Reservoir Frequency Analysis (RMC-RFA) software to facilitate hydrologic hazard 
assessments within the USACE Dam Safety Program [7]. RMC-RFA produces a reservoir stage-frequency curve with 
uncertainty bounds by utilizing a deterministic flood routing model while treating the inflow volume, the inflow flood 
hydrograph shape, the seasonal occurrence of the flood event, and the antecedent reservoir stage as uncertain 
variables rather than fixed values [5]. RMC-RFA can be downloaded from the following link, 
https://www.rmc.usace.army.mil/Software/RMC-RFA/. Results from an RMC-RFA analysis can be imported directly 
into RMC-TotalRisk.  

To import results of an RMC-RFA analysis, right-click on the Hazards folder in Project Explorer (Figure 59) or from 
the Project MenuHazards and select Add RMC-RFA Hazard…. A dialog will appear where you enter the name of 
the hazard function, select the RMC-RFA project file, select the output type, and select the simulation from the project 
that you would like to import.  

 
Figure 59 – Add new RMC-RFA hazard function and import dialog. 
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Once satisfied with the import settings, click OK (Figure 59) and the RMC-RFA hazard function will be added to the 
Hazards folder in Project Explorer, the function will be automatically opened into the Tabbed Documents area, and 
the input data properties will be displayed in the Properties Window (Figure 60). From here, you can set the Name, 
Description, Hazard Type, Hazard Units, and Hazard and Probability interpolation transforms as shown in Figure 
60 below. 

 
Figure 60 - RMC-RFA hazard function properties. 
 

As before with the RMC-BestFit hazard function, the RMC-RFA results can be viewed in either graphical or tabular 
form. For more information on these viewing options, see the Frequency Results section under RMC-BestFit. 

Parametric Function 
The parametric hazard option allows the user to define a hazard function using a parametric distribution. To create a 
parametric hazard function, right-click on the Hazards folder in Project Explorer (Figure 61) or from the Project 
MenuHazards and select Add Parametric Hazard…. Next, give the Parametric Hazard function a name and click 
OK.  

When the new Parametric Hazard function is created, it will be automatically opened into the Tabbed Documents 
area, and the parametric function properties will be displayed in the Properties Window. From the properties, you 
can set the Name, Description, Hazard Type and Hazard Units. Define the parametric distribution with uncertainty 
by setting the Effective Record Length, type of Distribution, and parameters for the distribution. Uncheck the Is 
Uncertain checkbox to use the parametric function without uncertainty. Once the parameters have been set, click the 
Compute button as shown in Figure 62 to generate and view the parametric hazard function. Further options for 
computing the parametric function are available in the Options tab which include bootstrap sampling Confidence 
Interval, number of Realizations, PRNG Seed for random number generation, and sample Probability Ordinates. 

The parametric frequency results can be viewed in either graphical or tabular form. For more information on these 
viewing options, see the Frequency Results section under RMC-BestFit. 
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Figure 61 – Create new Parametric hazard function. 

 

 
Figure 62 – Parametric Hazard Function properties. 
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Nonparametric Function 
The nonparametric hazard function option provides an easy way to define a parametric distribution using tabular data 
where uncertainty is defined by a single parameter, effective record length (ERL). The longer the ERL, the less 
uncertainty and narrower the confidence intervals [1]. The most common use case is copying and pasting a 
nonparametric frequency function from another application such as Microsoft Excel®, HEC-FDA, or HEC-SSP, then 
enter the ERL to define uncertainty. To create a nonparametric hazard function, right-click on the Hazards folder in 
Project Explorer (Figure 63) or from the Project MenuHazards and select Add Nonparametric Hazard…. Next, 
give the Nonparametric Hazard function a name and click OK.  

 
Figure 63 – Create New Nonparametric Hazard Function. 

 

When the new Nonparametric Hazard function is created, it will be automatically opened into the Tabbed Documents 
area, and the tabular function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, Hazard and Probability interpolation transforms, 
Effective Record Length, and Extrapolation Probability as shown in Figure 64. The hazard and probability 
interpolation transforms define how the data is interpolated when sampling values between the specified tabular 
ordinates. Effective Record Length is used for estimating uncertainty in the nonparametric function. The 
Extrapolation Probability input is used to extrapolate to a less frequent exceedance probability. If the user defined 
data already extends beyond the entered value, no extrapolation will be performed. DRAFT
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Figure 64 – Nonparametric Hazard Function properties. 

 

The Tabbed Document for a nonparametric function contains the table where tabular data is entered and a graphical 
representation of that data (Figure 65). Data can be entered manually into the table or pasted from another source 
such as Microsoft Excel®. 

 
Figure 65 – Nonparametric Hazard Function completed flow-frequency function. 
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Tabular Function 
The tabular hazard function option provides an easy way to define a hazard function using tabular data. The most 
common use case is copying and pasting a frequency function from another application such as Microsoft Excel® or 
HEC-SSP. To create a tabular hazard function, right-click on the Hazards folder in Project Explorer (Figure 66) or 
from the Project MenuHazards and select Add Tabular Hazard…. Next, give the Tabular Hazard function a 
name and click OK.  

 
Figure 66 – Create New Tabular Hazard Function. 

 

When the new Tabular Hazard function is created, it will be automatically opened into the Tabbed Documents area, 
and the tabular function properties will be displayed in the Properties Window. From the properties window, you can 
set the Name, Description, Hazard Type, Hazard Units, and Hazard and Probability interpolation transforms as 
shown in Figure 67. The hazard and probability interpolation transforms define how the data is interpolated when 
sampling values between the specified tabular ordinates.  

 
Figure 67 – Tabular Hazard Function properties. 
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The Tabbed Document for a tabular function contains the table where data is entered, and a graphical representation 
of that data is provided (Figure 68). Uncertainty can be defined around either the hazard or the probability by checking 
the Hazard Is Uncertain checkbox in the top left of the document. A distribution must be selected to define 
uncertainty, parameters for the selected distribution must be entered for every ordinate in the tabular data. Data can 
be entered manually into the table or pasted from another source such as Microsoft Excel®. 

 
Figure 68 – Tabular Hazard Function completed tabular reservoir stage frequency function. 

 

Data Validation 
The input data table has built-in validation. The Tabular Data has the following requirements: 

• Hazard values must be in ascending order. 

• Probability values must be in descending order since they are exceedance probabilities. 

• If uncertainty is defined, uncertain ordinates must contain valid distribution parameters. The uncertainty 
bounds must also be ordered. 

• Probability values must be between 0 and 1. 

 
When invalid data is entered, the table cell will turn red, and provide a tooltip indicating the source of the error as 
shown in Figure 69. In addition, an error message will appear in the Message Window indicating that you must 
resolve all errors in the data table.  
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Figure 69 – Input Data Validation. 

Composite Function 
The composite hazard function option allows the user to combine multiple hazard functions into a single function by 
weighting the individual input functions. To create a composite hazard function, right-click on the Hazards folder in 
Project Explorer (Figure 70) or from the Project MenuHazards and select Add Composite Hazard…. Next, give 
the Composite Hazard function a name and click OK.  

 
Figure 70 – Create new Composite Hazard Function. 

 

When the new Composite Hazard function is created, it will be automatically opened into the Tabbed Documents 
area, and the composite function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, and input Hazard Functions as shown in Figure 
71. The Hazard functions table is where the input functions are to be defined. Click the Add Row(s) button in the 
Hazard Functions table toolbar to add new rows for input to the composite. The hazard function weights must sum to 
1. The user has the option to combine the functions using the probability of union assuming each hazard function is 
independent by unchecking the Is Mixture checkbox. 
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Figure 71 – Composite Hazard Function properties. 

  

The Tabbed Document for a composite function contains a graphical representation of the composite function 
(Figure 72). DRAFT
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Figure 72 – Composite Hazard Function graphical display. 

Transform Functions 
In RMC-TotalRisk, transform functions will transform from one hazard type into another hazard type. For example, a 
peak flow-frequency function can be transformed to a stage-frequency function using a flow-stage rating curve derived 
from a hydraulic model. 

Linear Function 
The linear transform option allows the user to transform a hazard from one type to another using a simple linear 
function. To create a linear transform function, right-click on the Transforms folder in Project Explorer (Figure 73) or 
from the Project MenuTransforms and select Add Linear Transform…. Next, give the Linear Transform 
function a name and click OK.  

 
Figure 73 – Create new Linear Transform Function. 

 

When the new Linear Transform function is created, it will be automatically opened into the Tabbed Documents area, 
and the transform function properties will be displayed in the Properties Window. From the properties window, you 
can set the Name, Description, Hazard Type, Hazard Units, Transformed Hazard, Transformed Units, and linear 

DRAFT



 
RMC-TotalRisk User Guide 

 

 

  
50 

 

transform Parameters as shown in Figure 74. The function is defined as 𝑌𝑌 =  𝛼𝛼 +  𝛽𝛽𝛽𝛽 +  𝜖𝜖, where  𝜖𝜖~𝑁𝑁(0,𝜎𝜎). If the 
Is Uncertain checkbox is un-checked then the Standard Error (σ) parameter is removed and only the slope (𝛽𝛽) and 
intercept (𝛼𝛼) are required. 

 
Figure 74 – Linear Transform Function properties. 

 

The Tabbed Document for a linear transform function contains a graphical representation of the function (Figure 75). DRAFT
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Figure 75 – Linear Transform Function graphical display. 

 

Power Function 
The power transform option allows the user to transform a hazard from one type to another using a power function. To 
create a power transform function, right-click on the Transforms folder in Project Explorer (Figure 76) or from the 
Project MenuTransforms and select Add Power Transform…. Next, give the Power Transform function a name 
and click OK.  

 
Figure 76 – Create new Power Transform Function. 

 

When the new Power Transform function is created, it will be automatically opened into the Tabbed Documents 
area, and the transform function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, Transformed Hazard, Transformed Units, and 
power transform Parameters as shown in Figure 77. The function is defined as 𝑌𝑌 =  �𝛼𝛼 (𝑋𝑋 −  𝜉𝜉)𝛽𝛽�  ∙ 𝜖𝜖, where 
𝜖𝜖~𝑁𝑁(0,𝜎𝜎). The standard error 𝜎𝜎 should be in log-space. If the Is Uncertain checkbox is unchecked then the Standard 
Error (𝜎𝜎) parameter is removed and only the coefficient (𝛼𝛼), exponent (𝛽𝛽), and location (𝜉𝜉) are required. 
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Figure 77 – Power Transform Function properties. 

 

The Tabbed Document for a power transform function contains a graphical representation of the function (Figure 78). DRAFT
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Figure 78 – Power Transform Function graphical display. 

 

Tabular Function 
The tabular transform function option provides an easy way to define a hazard transform function using tabular data. 
The most common use case is copying and pasting a transform function (e.g., flow-stage rating curve) from another 
application such as Microsoft Excel® or HEC-RAS. To create a tabular transform function, right-click on the 
Transforms folder in Project Explorer (Figure 79) or from the Project MenuTransforms and select Add Tabular 
Transform…. Next, give the Tabular Transform function a name and click OK. 

 
Figure 79 – Create new Tabular Transform Function. 

 

When the new Tabular Transform function is created, it will be automatically opened into the Tabbed Documents 
area, and the tabular function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, Transformed Hazard, Transformed Units, and 
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Hazard and Transformed Hazard interpolation transforms as shown in Figure 80. The hazard and transformed 
hazard interpolation transforms define how the data is interpolated when sampling values between the specified 
tabular ordinates.  

 
Figure 80 – Tabular Transform Function properties. 

 

The Tabbed Document for a tabular function contains the table where tabular data will be entered and a graphical 
representation of that data (Figure 81). Uncertainty can be defined around the transformed hazard for each tabular 
ordinate. A distribution must be selected to define uncertainty, parameters for the selected distribution can be entered 
for every ordinate in the tabular data.  DRAFT
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Figure 81 – Tabular Transform Function transforming flow to stage. 

 

Data Validation 
The input data table has built-in validation. The Tabular Data has the following requirements: 

• Hazard and transformed hazard values must be in ascending order. 

• If uncertainty is defined, uncertain ordinates must contain valid distribution parameters. 

 
When you enter invalid data, the table cell will turn red, and provide a tooltip indicating the source of the error as 
shown in Figure 82. In addition, an error message will appear in the Message Window indicating that you must 
resolve all errors in the data table.  DRAFT
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Figure 82 – Input Data Validation. 

System Response Functions 
System response functions define how a system will respond given a hazard. In RMC-TotalRisk, a system response 
function describes the conditional probability of failure for various hazard levels, such as water surface elevations [8] 
[1]. Typically, the response function describes the probability of failure for a given hazard level. In dam and levee 
safety risk analyses, system response functions are developed for multiple potential failure modes (PFM). Common 
failure modes include seepage and piping, erosion and bank caving, and overtopping. It is important to keep the 
PFMs distinct in a risk analysis since each PFM can have different consequence outcomes. In RMC-TotalRisk, 
system response functions can be defined using an event tree, parametric function, tabular function, bivariate tabular 
function, or a composite of multiple functions. The following will go over each input option in detail. 

Event Tree Function 
RMC-TotalRisk provides the ability to define system response probabilities using an event tree. Event tree analyses 
(ETAs) represent the logic of how an initiating event, like a flood or earthquake, can lead to various types of damage 
and failure [3]. The event tree consists of a sequence of interconnected nodes and branches [9]. Each node is 
associated with an uncertain event (a crack forms in the embankment) or a state of nature (existence of adversely 
oriented joint planes). Branches originating from a node represent each of the possible events or states of nature that 
can occur. Probabilities are estimated for each node to represent the likelihood for each event or condition. These 
probabilities are conditional on the occurrence of the preceding events to the left in the tree. See [1] for more details 
on the event tree calculations in RMC-TotalRisk.  

To create an event tree response function, right-click on the System Responses folder in Project Explorer (Figure 
83) or from the Project MenuSystem Responses and select Add Event Tree Response…. A dialog will appear 
where you enter the name of the dataset and select an event tree template that you would like to import. This example 
will use the Basic template to show the development of an event tree from scratch. However, you can select from a 
list of default templates as well as user-defined templates. 
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Figure 83 – Create new Event Tree Response Function. 

 

When the new Event Tree Response function is created, it will be automatically opened into the Tabbed Documents 
area, and the event tree properties will be displayed in the Properties Window. From the properties window, you can 
set the Name, Description, Hazard Type, Hazard Units, Hazard Interpolation, Probability Interpolation, and 
selected Event Tree Node properties as shown in Figure 84. The hazard and probability interpolation transforms 
define how the data is interpolated when sampling values between hazard and probability intervals.  
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Figure 84 – Event Tree Response Function properties. 

 

Terminology 
This section provides definitions for the event tree terminology used in RMC-TotalRisk [1]. 

• Node: A branching point in the event tree that signifies a random event in the event tree. This is also 
commonly referred to as an event or state. There are four basic node types that define the event tree:  

 Initiating Hazard Node: Always the first node in an event tree. This node defines the hazard levels. It is 
crucial to relating system response probabilities to the hazard function. For a more accurate assessment 
of risk, probabilities should be defined for enough hazard levels to cover nearly the entirety of probability 
space. Only hazard levels are entered for this node, not hazard exceedance probabilities. 

 Chance Node: Represents the probability that the given event will occur for each hazard level defined in 
the initiating hazard node. Probabilities can be defined as a single value for all hazard levels (Single 
Value), unique for each hazard level (Multi Value), or from another source (see reference node below). 
This is the most fundamental component of an event tree.  

 Reference Node: The reference node performs the same task as a chance probability node except that 
instead of probability being defined at the node itself, it is defined using a previously added response 
function or node in the event tree. The selected function or node can be sampled independently or the 
same for all references to the source. 
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 Remainder Node: This node represents the probability that remains when all other chance node and 
reference node probabilities for the current branching point are considered. For example, from a given 
event with two potential outcomes the remainder node represents the probability that neither of the 
potential outcomes occurs. The remainder probability is computed automatically and is not set by the 
user. 

• Branch: The line that connects two nodes together.  
 

• End Node: A node that has no downstream branches. The end node defines the end state for a sequence of 
events. This is also commonly referred to as a leaf node or terminal node.  
 

• Pathway: A unique sequence of events representing a possible failure progression. The probability of this 
pathway occurring is computed as the joint probability of each node in the series that connects the initiating 
hazard node to the end node. This is also commonly referred to as path, sequence, connections, or root-to-
node.  
 

• Upstream Nodes: All nodes to the left of a selected node in the tree. The upstream nodes of the selected 
node must occur prior to the selected node event. This is also commonly referred to as parent node, 
conditional events, or preceding nodes.  
 

• Downstream Nodes: All nodes to the right of a selected node in the tree. The downstream nodes occur after 
the selected node event. This is also commonly referred to as child node, conditional events, proceeding 
nodes, or subsequent nodes. 
 

• Node Probability: The probability that the selected node event occurs conditioned on the occurrence of the 
upstream nodes in the tree.   
 

• Event Likelihood: The likelihood, or probability, of a node occurring in the event tree for a given hazard level. 
This is the joint probability of the selected node event and all the upstream nodes occurring.  

 

Navigating an Event Tree 
The event tree can be moved around the workspace by click-and-holding any mouse button on the background 
canvas and dragging the mouse. You can zoom in and out using the mouse wheel. A node or branch will become 
highlighted when the cursor is over it. Nodes and branches can be selected by left-clicking on them. Right-clicking on 
a node or branch will display the context menu options. 

When the mouse cursor is hovering over any node a toolbar will appear just above the node as shown below. The 
toolbar options are also available by right-clicking on a node. 

 
Figure 85 – Event Tree Node Toolbar. 

 

 Delete Branches Click to delete all child branches from the target node. 

 Copy Branches Click to copy the child nodes into memory to be pasted elsewhere. 

 Paste Branches Click to paste previously copied branches to this node. 

 Add New Branch Click to add a new branch to the node. 

 

When the mouse cursor is hovering over any branch a toolbar will appear just above the branch name as shown 
below. The branch toolbar options are also available by right-clicking on the branch. A branch can be renamed by 
double-clicking on the branch or through the branch properties. 
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Figure 86 – Event Tree Branch Toolbar. 

 

 Delete Branch Click to delete the target branch and all child branches from the event tree. 

 Branch Properties Click to edit branch properties (e.g., name, description, probabilities) directly in the 
workspace. 

 Save Template Save the event tree as a template for future use. This option is only available on initiating 
hazard nodes. 

 

Customizing an Event Tree 
Tools to customize the look of your event tree can be found in the Options tab within the event tree Properties 
Window (Figure 87).  

• Height Defines the height, in pixels, of each node. Changing the height to greater than 70 will allow the node 
names to be on more than 1 line. 

• Width Defines the width, in pixels, horizontally between each node. 

• Smooth Defines the smoothness of the connector lines between nodes. 

• Extend If checked, this option will extend the terminal leaf nodes to the right-most column in the event tree. 

• Background Color Defines the background color in the event tree workspace. 

• Gridline Color Defines the background grid line color in the event tree workspace. 

• Node Fill Defines the fill color for the specified node. 

• Node Stroke Defines the outline color for the specified node. 

• Reset If this button is pressed, the options will be reset back to their default settings. 

• Zoom Scale Defines the current zoom scale factor for the event tree workspace. A value of 1 means that the 
event tree is at the base zoom level.  
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Figure 87 – Event tree style options. 

 

Building an Event Tree 
The following example represents an event tree developed for spillway erosion. The sequence of events are as 
follows: Pool elevation rises producing spillway flow, grass in spillway is removed, headcut initiates, headcut 
advances to control section, failure of control structure, unsuccessful intervention, breach. 

1) Define the hazard. Click on the Initiating Hazard Node branch, Hazard, to select it. Once selected, edit in the 
Properties Window under the Selected Branch Properties sub-section (Figure 88). Alternatively, the 
branch can be edited by clicking the branch properties button, , in the event tree node toolbar. Change the 
name to Pool Elevation and,  

2) Use the table editing tools to enter the desired Hazard Levels. 
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Figure 88 – Event tree selected node properties editor in the properties window and from the node toolbar options, completed 
Initiating Hazard Node. 

 

3) Next, delete the Fail node that was added by default by either clicking the delete button  in the toolbar or in 
the SUB-BRANCHES properties of the Initiating Hazard Node. A message will appear requiring confirmation 
of the deletion. Click Yes to confirm deleting the unwanted node. 

4) Add the next node in the event tree by clicking the Add Branch button  in the node toolbar, right-click node 
context menu, or in the SUB-BRANCHES properties section. Using the node properties editor, change the 
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name of the new node, add a description, and define the probability of the event for each hazard level defined 
in step 1 as shown in Figure 89 below.  
 

 
Figure 89 –Properties for the Grass Removal probability event tree node. 

 

5) Continue this process of adding nodes and defining the properties until the event tree is complete as shown in 
Figure 90 below. DRAFT
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Figure 90 – Completed spillway erosion event tree. 

 

Event Tree Results 
The Tabbed Document contains three tabs: Event Tree, Response, and Diagnostics. RMC-TotalRisk provides 
several tools for exploring the results of the event tree analysis. The event tree is built and edited in the Event Tree 
tab as discussed in the sections above. The Response tab contains a graphical representation of the system 
response function for each hazard level. This is commonly referred to as a fragility curve and represents the 
probability of failure for each hazard level defined. The function data can be exported as tabular data using the export 
plot data button. 
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Figure 91 – System response probability function result from event tree. 

 

The Diagnostics tab contains several tools for reviewing and validating the event tree calculations. Options for 
reviewing the event tree results are available on the left side of the Diagnostics tab. Options include Node Filters, 
Model Parameters, and Plot Options (Figure 92). Each viewing option is detailed below: 

 
Figure 92 – Event tree diagnostic viewing options. 

 

Node Filters Filter the visible plot data.  

• Show Remainder Nodes Turns on or off displaying remainder nodes in the results. 
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• Combine Remainder Leaves If checked, the terminal remainder nodes are combined in the results. This is 
often akin to the probability of non-failure as each remainder node often represents non-fail conditions. 

• Leaf Nodes Only If checked, only terminal leaf nodes are displayed. A leaf node is any node that doesn’t 
have any child nodes. 

Model Parameters Defines how the event tree is analyzed for review. 

• Monte Carlo Iterations Defines the number of Monte Carlo iterations used to sample the event tree for 
diagnostic analysis. If no uncertainty is present, this option is disabled. 

• Hazard Level Defines the hazard level that the diagnostic results are calculated at.  

Plot Options Provides various plots and tables to analyze the event tree results. 

• Event Likelihood Displays the likelihood of each node occurring in the event tree for the given hazard level 
(defined in the Model Parameters) as a box and whisker plot (Figure 93).  

• Correlation to SRP Displays the Pearson’s correlation coefficient for how each node’s sampled probabilities 
correlate to the overall system response probability (SRP). Chance nodes will have a positive correlation with 
the SRP, whereas remainder nodes will have a negative correlation. The absolute size of the correlation 
coefficient indicates the strength of the association with SRP [1]. The nodal correlations to SRP are displayed 
as a ranked tornado plot shown in Figure 94 below.  

• Sensitivity Index Displays each node’s first-order sensitivity index, or main effect index (Figure 95). This is 
the contribution to the output variance. It measures the effect of varying a single node but averaged over 
variations in other input parameters. It is standardized by the total variance to provide a fractional contribution. 
A node with a high sensitivity index is a good indicator that reducing the nodes uncertainty will have a large 
impact on the overall SRP [10, 1]. 

• Node SRP Scatter This option allows the user to see the sampled values for a given node plotted against the 
overall SRP for each Monte Carlo iteration. A node with a strong correlation to SRP will show a clear trend 
between the sampled node probability and overall SRP as shown in Figure 96 below. 

• Tabular This option allows the user to view the individual node’s sampled probabilities and overall SRP for 
each Monte Carlo iteration in the model in table form (Figure 97). Using the table features, verification of node 
distribution sampling can be accomplished through the column statistics as shown in Figure 98 below. 

 

 
Figure 93 – Event tree diagnostics event likelihood plot option. 
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Figure 94 – Event tree diagnostics tree node correlation to SRP plot. 

 

 
Figure 95 – Event tree diagnostics tree node sensitivity indices. 
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Figure 96 – Event tree diagnostics tree node probability to SRP scatter plot. 

 

 
Figure 97 – Event tree diagnostics tabular output. 
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Figure 98 – Column statistics for the Unsuccessful Interventions node’s sampled probabilities confirming that the node distribution 
(Triangular) is being sampled correctly. 

 

Parametric Function 
The parametric response function option allows the user to define a system response function using a parametric 
distribution. To create a parametric response function, right-click on the System Responses folder in Project 
Explorer (Figure 99) or from the Project MenuSystem Responses and select Add Parametric Response…. 
Next, give the Parametric Response function a name and click OK.  DRAFT
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Figure 99 – Create New Parametric Hazard Function. 

 

When the new Parametric Response function is created, it will be automatically opened into the Tabbed Documents 
area, and the parametric function properties will be displayed in the Properties Window. From here, you can set the 
Name, Description, Hazard Type and Hazard Units. The parametric function is defined in the properties window. 
Define the parametric distribution by setting the Effective Record Length, type of Distribution, and parameters for 
the distribution. Once the parameters have been set, click the Compute button to generate and view the parametric 
response function as shown in Figure 100. Further options for computing the parametric function are available in the 
Options tab which include bootstrap sampling Confidence Interval, number of Realizations, PRNG Seed for 
random number generation, and sample Probability Ordinates. 

 
Figure 100 – Parametric Response Function properties. 

 

Identical to the RMC-BestFit, RMC-RFA, and Parametric hazard functions, the frequency results can be viewed as 
graphical or tabular data. For more information on these viewing options, see the Frequency Results section under 
RMC-BestFit. 
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Tabular Function 
The tabular response function provides an easy way to define a system response function using tabular data. The 
most common use case is copying and pasting from another application such as Microsoft Excel®. To create a 
tabular response function, right-click on the System Responses folder in Project Explorer (Figure 101) or from the 
Project MenuSystem Responses and select Add Tabular Response…. Next, give the Tabular Response 
function a name and click OK.  

  
Figure 101 – Create New Tabular Response Function. 

 

When the new Tabular Response function is created, it will be automatically opened into the Tabbed Documents 
area, and the tabular function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, and Hazard and Probability interpolation 
transforms as shown in Figure 102. The hazard and probability interpolation transforms define how the data is 
interpolated when sampling values between the specified tabular ordinates.  
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Figure 102 – Tabular Response Function properties. 

 

The Tabbed Document for a tabular function contains the table where tabular data will be entered and a graphical 
representation of that data (Figure 103). A distribution must be selected to define uncertainty, parameters for the 
selected distribution can be entered for every ordinate in the tabular data. Data can be entered manually into the table 
or pasted from another source such as Microsoft Excel®. 

DRAFT



 
RMC-TotalRisk User Guide 

 

 

  
73 

 

 
Figure 103 – Tabular Response Function completed tabular probability of failure given reservoir stage. 

 

Data Validation 
The input data table has built-in validation. The Tabular Data has the following requirements: 

• Hazard values must be in ascending order. 

• Probability values must be between 0 and 1. 

• If uncertainty is defined, uncertain ordinates must contain valid distribution parameters. 

 
When you enter invalid data, the table cell will turn red, and provide a tooltip indicating the source of the error as 
shown in Figure 104. In addition, an error message will appear in the Message Window indicating that you must 
resolve all errors in the data table.  
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Figure 104 – Input Data Validation. 

 

Bivariate Function 
The Bivariate Response function option provides an easy way to define a system response function with two hazards 
using tabular data. In many cases a bivariate response function will be defined using the event tree tools. However, 
when available a bivariate probability table can be copied and pasted from another application such as Microsoft 
Excel®. To create a bivariate response function, right-click on the System Responses folder in Project Explorer 
(Figure 105) or from the Project MenuSystem Responses and select Add Bivariate Response…. Next, give the 
Bivariate Response function a name and click OK.  

  
Figure 105 – Create New Bivariate Response Function. 

 

When the new Bivariate Response function is created, it will be automatically opened into the Tabbed Documents 
area, and the bivariate function properties will be displayed in the Properties Window (Figure 106). From here, you 
can set the Name, Description, Primary Hazard, and Primary Hazard Units. You can also set the Interpolation 
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Transforms for the Primary Hazard and Probabilities. Finally, the properties window is where the primary and 
secondary Hazard Levels are defined. Use the table tools to add the desired hazard levels for the primary and 
secondary hazards. The primary and secondary hazard levels must be in ascending order. A weight is required for 
each secondary hazard level. The weights are used on the secondary hazard levels during the risk compute to define 
a weighted probability associated with each primary hazard level. The weight values must sum to 1. Weights can be 
manually entered or automatically calculated using a specified Hazard Function. See [1] for more details on bivariate 
hazard properties. 

  
Figure 106 – Bivariate Response Function properties.  

 

As the primary and secondary hazard levels are entered in the Properties Window, the table at the top of the 
Tabbed Document is automatically updated where each row is a primary hazard level and each column is a 
secondary hazard level. To complete the bivariate response function, enter the associated probability of failure in 
each cell given the primary hazard (row) and secondary hazard (column) as shown in Figure 107. Below the table is a 
graphical representation of the system response functions for each secondary hazard level. 
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Figure 107 – Bivariate response function tabbed document. 

 

Composite Function 
The composite response function option allows the user to combine multiple response functions into a single function 
by weighting the individual input functions. To create a composite response function, right-click on the System 
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Responses folder in Project Explorer (Figure 108) or from the Project MenuHazards and select Add Composite 
Response…. Next, give the Composite Response function a name and click OK.  

 
Figure 108 – Create New Composite Response Function. 

 

When the new Composite Response function is created, it will be automatically opened into the Tabbed Documents 
area, and the composite function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, and input Response Functions as shown in 
Figure 109. The Response functions table is where the input functions are to be defined. Click the Add Row(s) button 
in the Response Functions table toolbar to add new rows for input to the composite. The response function weights 
must sum to 1. The user has the option to combine the functions using the probability of union assuming each 
response function is independent by unchecking the Is Mixture checkbox. 

 

 
Figure 109 – Composite Response Function properties. 

 

The Tabbed Document for a composite function contains a graphical representation of the composite function 
(Figure 110). 
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Figure 110 – Composite Response Function graphical display. 

Consequence Functions 
Consequence functions in RMC-TotalRisk represent the magnitude of consequences that will occur for a given range 
of hazards. In other words, how much life loss or economic damage is expected for a given hazard level and the 
associated system response. It is common in dam and levee safety risk analyses for consequence functions to be 
defined separately for each PFM because consequence estimates can change depending on which failure mode is 
being assessed. For example, an overtopping failure mode may have a very different warning time than an 
earthquake driven failure resulting in different life loss estimates. In RMC-TotalRisk, consequence functions can be 
defined by importing directly from a LifeSim v 2.0 model, as a tabular function, or as a composite function. The 
following will go over each input option in detail. 

LifeSim 
The USACE-RMC, in collaboration with the Hydrologic Engineering Center (HEC), developed the life loss and 
economic damage estimation software LifeSim [11] [12]. LifeSim is an agent-based system for estimating life loss with 
the fundamental intent to simulate population redistribution during an evacuation [13]. Life loss and economic 
damages are then determined by the hazard (e.g., flooding). LifeSim can be downloaded from the following link, 
https://www.rmc.usace.army.mil/Software/LifeSim/. Results from a LifeSim analysis can be imported directly into 
RMC-TotalRisk.  

To import results of a LifeSim analysis, right-click on the Consequences folder in Project Explorer (Figure 111) or 
from the Project MenuConsequences and select Add LifeSim Consequence…. A dialog will appear where you 
enter the name of the dataset and select the LifeSim project file that contains the desired results.  
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Figure 111 – Create New LifeSim Consequence Function. 

 

Once satisfied with the import settings, click OK (Figure 111) and the LifeSim study results will be imported to the 
study. When the new LifeSim consequence function is created, it will be automatically opened into the Tabbed 
Documents area, and the function properties will be displayed in the Properties Window (Figure 106). From here, 
you can set the Name, Description, Hazard Type, Hazard Units, and Hazard and Consequence interpolation 
transforms as shown in Figure 112. The hazard and consequence interpolation transforms define how the data is 
interpolated when sampling values between the specified LifeSim results.  

The LifeSim Results section contains three important parameters to consider when selecting results from a LifeSim 
analysis.  

• Consequence: Determines what type of consequence will be selected from the LifeSim results. The options 
are Life Loss and $ Damages. 

• Starting Hazard: The hazard level where consequences begin to occur. This parameter provides a lower 
bound for the consequence function. The starting hazard level must be below the lowest value defined in the 
imported LifeSim results. 

• Combine Zones: If checked, selected LifeSim results are from the entire simulation area. If unchecked, 
specific summary zones (regions) must be selected from LifeSim results. LifeSim allows results to be 
geographically separated by summary zone allowing for more flexibility when creating consequence functions. DRAFT
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Figure 112 – LifeSim consequence function properties. 

 

The LifeSim consequence function is created in the Tabbed Document. The consequence function is defined by 
entering hazard levels (e.g., reservoir pool elevations or river flows) and LifeSim simulation results using the table on 
the left. A graphical representation of the function is displayed to the right of the table (Figure 114). There are three 
steps to entering each LifeSim result: 

1. Use the table tools to add rows for each desired hazard level (e.g., 2-yr, 10-yr, 50-yr, 100-yr floods). The 
hazard levels entered must be in ascending order.  

2. For each defined hazard level, select a LifeSim simulation result from the dropdown menu(s). The Filtered 
View checkbox can make it easier to navigate LifeSim results by filtering the cell contents to only contain 
results from the selected Simulations/Alternatives/Times of day. For example, in Figure 114 below the only 
options in the Alternative column are from the FWOP simulations and the available Hazard Time(s) are based 
on the selected Simulation-Alternative combination. 

3. Once a LifeSim simulation result has been selected, multiple distributions will be auto-fit to the data and a 
truncated normal distribution will be selected to represent potential consequences with uncertainty at the 
specified hazard level. To view, change, or edit the selected distribution click on the button in the Distribution 
column cell. A popup appears (Figure 113) that shows the selected distribution, the distributions PDF, and a 
histogram of the LifeSim results data for a visual comparison of the distribution fit. Summary statistics are 
provided for both the selected distribution and the LifeSim results data including goodness of fit tests for the 
distribution and the data. 
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Figure 113 - LifeSim result distribution selector control. 
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Figure 114 – LifeSim consequence function tabbed document. 

 

Tabular Function 
The tabular consequence function option provides an easy way to define a consequence function using tabular data. 
The most common use case is copying and pasting from another application such as Microsoft Excel®. To create a 
tabular consequence function, right-click on the Consequences folder in Project Explorer (Figure 115) or from the 
Project MenuConsequences and select Add Tabular Consequence…. Next, give the Tabular Consequence 
function a name and click OK. 
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Figure 115 – Create new Tabular Transform Function. 

 

When the new Tabular Consequence function is created, it will be automatically opened into the Tabbed Documents 
area, and the tabular function properties will be displayed in the Properties Window. From the properties window, 
you can set the Name, Description, Hazard Type, Hazard Units, Consequence, Consequence Unit, and Hazard 
and Consequence interpolation transforms as shown in Figure 116. The hazard and consequence interpolation 
transforms define how the data is interpolated when sampling values between the specified tabular ordinates.  

 
Figure 116 – Tabular Consequence Function properties. 

 

The Tabbed Document for the Tabular Consequence Function contains the table where data will be entered and a 
graphical representation of that data (Figure 117). Uncertainty can be defined around the consequence for each 
tabular ordinate. A distribution must be selected to define uncertainty, parameters for the selected distribution must be 
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entered for every ordinate in the tabular data. Data can be entered manually into the table or pasted from another 
source such as Microsoft Excel®. 

 
Figure 117 – Tabular consequence function example. 

 

Data Validation 
The input data table has built-in validation. The Tabular Data has the following requirements: 

• Hazard values must be in ascending order. 

• If uncertainty is defined, uncertain ordinates must contain valid distribution parameters. 

 
When you enter invalid data, the table cell will turn red, and provide a tooltip indicating the source of the error as 
shown in Figure 118. In addition, an error message will appear in the Message Window indicating that you must 
resolve all errors in the data table.  
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Figure 118 – Input Data Validation. 

 

Composite Function 
The composite consequence function option allows the user to combine multiple consequence functions into a single 
function by either weighting the individual input functions or making them additive. A common use case is taking a 
daytime consequence function and combining it with a night-time function using a day-night weight ratio. Another 
common use case is to take damage functions by structure damage category and aggregate them into a single 
damage function. To create a composite consequence function, right-click on the Consequences folder in Project 
Explorer (Figure 119) or from the Project MenuConsequences and select Add Composite Consequence…. 
Next, give the Composite Consequence function a name and click OK.  

 

 
Figure 119 – Create new Composite Hazard Function. 

 

When the new Composite Consequence function is created, it will be automatically opened into the Tabbed 
Documents area, and the composite function properties will be displayed in the Properties Window. From the 
properties window, you can set the Name, Description, Hazard Type, Hazard Units, Consequence, Consequence 
Unit, Hazard and Consequence interpolation transforms, Additive option for selected inputs, and input 
Consequence Functions as shown in Figure 120.  

DRAFT



 
RMC-TotalRisk User Guide 

 

 

  
86 

 

 
Figure 120 – Composite Hazard Function properties. 

 

The Composite Type provides three options to define how the input functions will be composited:  

• Additive The input functions will be added together, no weights are required. 

• Average The input functions and their uncertainties are combined using a weighted average. The weights 
must sum to one. 

• Mixture The input functions and their uncertainties will be combined as a mixture. The weights must sum to 
one. This option results in the same mean as the average method with wider bands of uncertainty in the 
composited function. 

The Consequence Functions table is where the input functions are selected for composition. Click the Add Row(s) 
button  in the table toolbar to add new rows for input to the composite.  

 

The Tabbed Document for a composite function contains a graphical representation of the composite function 
(Figure 121). 
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Figure 121 – Composite Hazard Function graphical display. 
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Risk Analyses 
In RMC-TotalRisk, the risk analysis is composed of three fundamental components: the hazard, system responses to 
that hazard, and consequences given response and hazard. These fundamental components are called System 
Components. For a given hazard, there can be multiple system response functions, commonly called failure modes, 
where each failure mode could potentially have a different consequence outcome. For example, a dam a seepage 
failure mode may be slow to progress to breach, which provides more time for people downstream to evacuate; 
whereas for a seismic failure mode the population downstream have little time to evacuate. A non-failure mode does 
not have a response function. There can only be one non-failure mode per system component. A risk analysis can 
have multiple system components, which can represent multiple structures in a system or multiple hazard types for a 
single structure. A risk analysis must have at least one system component. A non-failure mode is required to calculate 
the risk of non-failure, background risk, and incremental risk. If no non-failure mode is supplied, the non-failure 
consequence is assumed to be zero. At least one failure mode is required to calculate incremental, failure, and non-
failure risk. For more details on the quantitative risk analysis framework in RMC-TotalRisk, see the technical reference 
manual [1]. 

Create New Risk Analysis 
To create a risk analysis, right-click on the Risk Analyses folder in Project Explorer (Figure 122) or from the Project 
Menu and select Add Risk Analysis…. Next, give the Risk Analysis function a name and click OK. 

 
Figure 122 - Create new risk analysis. 

 

When the new Risk Analysis is created, it will be automatically opened into the Tabbed Documents area, and the risk 
analysis properties will be displayed in the Properties Window (Figure 123).  

Risk Analysis Properties 
From here, you can set the Name, Description, Consequence, and Consequence Units. The consequence and 
consequence units are required, and each consequence function used in the analysis must match the selected 
consequence type. Here you can also run the risk simulation once it has been defined. When estimating risk, you can 
either Simulate Mean Risk Only which simply uses the mean result from each input function, or you can Simulate 
Risk with Full Uncertainty which uses Monte Carlo simulation to estimate risk using the full range of uncertainty 
from each input function. To calculate a risk estimate, click the Estimate button. 
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Figure 123 - Risk analysis properties. The general properties are shown on the left and the risk analysis options are shown on the 
right. 
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Risk Analysis Options 
The risk analysis options can be accessed through the Properties Window in the Options tab (Figure 123). For 
typical applications, the default risk analysis options should provide reasonable results out of the box. The following 
subsections provided details on the available risk analysis options.  

Simulation Options 
The simulation options provide settings for the uncertainty analysis and the F-N curve results. The following options 
are available: 

• Confidence Interval (CI): The width of the confidence interval. For a 90% confidence interval, the value of 
interest lies with a 90% probability in the interval. Confidence intervals are only computed after simulating risk 
with full uncertainty. The default CI is 90%.  

• Realizations: Determines the number of Monte Carlo simulation realizations when simulating risk with full 
uncertainty. The default is 1,000 to ensure reasonably accurate confidence intervals and shorter runtimes. 
Due to runtime and file size limitations, the maximum number of Monte Carlo realizations allowed is 10,000. 
As such, there is a potential for minor sampling errors in the mean risk results and percentiles. It is 
recommended to run 10,000 realizations to get the most accurate results. 

• PRNG Seed: The pseudo random number generator (PRNG) seed value used within the Monte Carlo 
simulation. Using the same seed value ensures repeatability. By changing the seed value, the sequence of 
random numbers will change. 

• F-N Output Length: The number of points used to construct the F-N curves. An F-N curve plots the risk 
results with consequences (N) on the x-axis and the exceedance probability, or frequency of occurrence, (F) 
on the y-axis. It is recommended to use at least 200 points to improve the accuracy of the curves. 

Integration Options 
In RMC-TotalRisk, within every Monte Carlo realization, risk is computed using numerical integration. When there is 
just a single system component in the risk analysis, the Adaptive Simpson’s Rule (ASR) is used to perform the 
numerical integration. The options for the ASR method are as follows: 

• Max Evaluations: The maximum number of integrand evaluations allowed when performing numerical 
integration. This value must be between 10,000 and 1,000,000. The default value is 1,000,000. 
 

• Max Depth: The maximum recursion depth when performing ASR integration. The default is 100.  
 

• Tolerance: The desired tolerance for the ASR integration. The default is 10−8.  

When there are two or more system components in the risk analysis, the adaptive importance sampling method 
VEGAS is used to perform the numerical integration. The options for the VEGAS method are as follows: 

• Max Evaluations: The maximum number of integrand evaluations allowed when performing numerical 
integration. This value must be between 10,000 and 1,000,000. The default value is 1,000,000. 
 

• Warmup Evaluations: The number of integrand evaluations each warmup cycle. The default is 1,000 ∙ 𝐷𝐷 
warmup evaluations, where 𝐷𝐷 is the number of integrand dimensions (i.e., system components).  
 

• Warmup Cycles: The number of warmup cycles for the adaptive importance sampling method. The default is 
5 warmup cycles.  
 

• Final Evaluations: After the warmup is completed, the final number of integrand evaluations for the adaptive 
importance sampling method. The default is 10,000 final integrand evaluations.  

More details on the numerical integration methods employed by TotalRisk are provided in the technical reference [1]. 

System Component Options 
The following system component options are available: 

• System Component: A system component is composed of three fundamental inputs: the hazard, system 
response to that hazard, and consequences given the response and hazard. A system component is 
identified and labeled by the selected hazard function. The selected hazard function can only be used once 
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per risk analysis. A single risk analysis is limited to 20 system components due to virtual memory and 
computer runtime limitations. Options are available for how each system component will be computed in the 
risk analysis. 

• Failure Mode Method: Determines how multiple failure modes are modeled in the risk analysis. By default, 
the Common Cause Adjustment (CCA) method is used.  

• Joint Consequences: If the joint failure mode method is selected, this option determines how the 
consequences of joint failures are treated in the risk analysis. The options are additive, average, maximum, 
and minimum. By default, when joint failures occur among failure modes in the system component, the 
maximum of the joint consequences will be recorded.  

In the context of dam and levee safety, additive consequences can be useful when each failure mode has a 
different inundation area where the consequences for the joint failure are best represented by adding the 
consequences for each inundation area. Average consequences can be used if the inundation areas are 
partially overlapping. If each failure mode has practically the same inundation area, then the maximum rule 
can be used so that consequences are not overestimated. The minimum rule can be used as a sensitivity or 
as a lower bound for risk.  

• Profile Hazard Type: The hazard type used for constructing the risk profiles and used for estimating the 
probability of exceeding the hazard threshold. The user can choose from the primary hazard function or any 
of the hazard-to-response transform functions. For a levee accreditation analysis, the profile hazard type 
should be stage or water surface elevation. 

• Hazard Threshold: The probability of hazard levels exceeding the threshold will be recorded in the risk 
simulation. The default hazard threshold is 0. For a levee accreditation analysis, the hazard threshold should 
be the top of levee height or elevation.  

System Options: 
The system options determine how the system components interact in the risk calculations. The following system 
options are available.  

• Component Dependency: Determines the dependency between system components in the risk analysis. 
The dependency between system components is modeled by the joint probability of the hazard functions. The 
options are independent, perfectly negative, perfectly positive, or a user-defined correlation matrix. If the 
correlation matrix is selected, a table is presented for the user to enter correlation coefficients between 
components. By default, each system component is assumed to be independent of one another. 

• Correlation Matrix: This is only available when correlation matrix is selected for component dependency. 
Clicking the button will display a table for the user to enter correlation coefficients between system 
components.  

• Joint Consequences: Determines how the consequences of joint events are treated in the risk analysis. The 
options are Additive, Average, Maximum, Minimum, Multiplicative. By default, when joint events occur among 
components in the system, the maximum of the joint consequences will be recorded. However, there are 
cases where other methods are more appropriate. For example, if the system components have 
nonoverlapping inundation areas, then additive consequences would be more appropriate. 

Risk Measure Options 
RMC-TotalRisk provides additional risk measures that are useful for risk-based design of engineering structures. The 
risk measures are computed for the overall system, not the individual system components. The risk measure options 
are as follows: 

• Consequence Threshold: The probability of consequences equal to or exceeding the threshold will be 
recorded in the risk simulation. The default consequence threshold is 0. 

• Alpha: The exceedance probability for computing the Value-at-Risk (VaR) and Conditional Value-at-Risk 
(CVaR). The default exceedance probability is 10−2. 

More details on the additional risk measures in TotalRisk are provided in the technical reference [1]. 
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Risk Analysis Tabbed Document 
The Tabbed Document for the Risk Analysis contains five tabs: The risk Diagram, F-N Plot, α-η Plot, Summary 
Statistics, and Diagnostics. The contents of each tab are detailed below. 

Risk Diagram 
A risk analysis in RMC-TotalRisk is defined through a diagram as shown in Figure 124 below. The diagram provides 
an intuitive way to create and connect the various components of the modeled system.  

A risk analysis computes the risk associated with a collection of potential failure modes for each component in the 
system. A failure mode is composed of a hazard, the system response to the hazard, and the consequences given the 
response to the hazard. A non-failure mode is composed of a hazard and the non-failure consequences given the 
hazard. 

Figure 124 shows a single system component for a dam safety risk analysis. There is a non-failure mode, shown at 
the top of the diagram with the purple line, that connects the hazard function to the non-failure consequences, without 
any system response. For many dams, there will often be consequences even if the structure does not fail. For 
example, during a major flood event, a dam could activate the emergency spillway, preventing the dam from reducing 
downstream flooding. The non-failure mode is used to model the risk of non-failure [1]. There are two failure modes: 
1) A spillway erosion failure mode, labelled PFM 1, shown in the center of the diagram connects the hazard function 
at Dam A to the PFM 1 response function and consequence function; and 2) A concentrated leak erosion failure 
mode, labelled PFM 2, shown in the bottom of the diagram with the same respective connections.  

 
Figure 124 – RMC-TotalRisk risk diagram. 

 

In the risk diagram, the input functions are connected from left to right, and linked together based on the hazard type 
(e.g., stage, flow, etc.) and units (e.g., ft, cfs, etc.) of each function. There cannot be any circular or redundant 
connections. As such, the risk diagram is a type of directed acyclic graph (DAG).  
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The system components are identified and labeled by the selected hazard function. The failure modes within a 
component are identified and labeled by the selected response functions. RMC-TotalRisk permits an unlimited 
number of failure modes per component, depending on the selected failure mode method. However, a single system 
is limited to 20 components due to virtual memory and computer runtime limitations. For example, the system risk of a 
watershed comprising up to 20 dams, each with 20 failure modes, can be assessed.  

Creating a Diagram 
First, get a feel for working with the diagram. Left-click-drag any open area in the diagram to pan the diagram surface. 
Mouse-wheel in and out to zoom the diagram. 

Inputs to the risk analysis are designated using nodes in the diagram. Select the desired input function for a node 
using the selection box. Left-click-drag on any node to move the node around the diagram. Each node will have 
required inputs, shown as a blue circle on the bottom-left side of the node. Node output is shown as an orange circle 
on the lower-right side of the node. 

There are three ways to add a node to the risk diagram as shown in Figure 125: a) place the mouse cursor over the 
large plus symbol in the upper left hand corner of the diagram; b) right-click on any empty space in the diagram to add 
at that location; and c) left-click on a node output. The third option has the added benefit of automatically connecting 
the new node to the clicked node output. 

 
Figure 125 - Options to add a new input node to the risk diagram: a) Move cursor over the plus symbol in the upper left corner of 
the diagram; b) Right-click on any empty space in the diagram to add at that location; and c) left-click on a node output, this option 
will also connect the nodes. 

 

To connect two nodes, left-click-hold on a node output and drag towards the node you want to connect. A line will 
appear from the node output to the mouse cursor. Move the mouse cursor over the input of the desired node and 
release the mouse button to connect. 

 
Figure 126 - Instructions for connecting a node to another node. left-click-hold on a node output and drag to the desired node input. 
Release the mouse button to finish the connection. 

 

To delete a node, you can either right-click on the node and select delete or click the x that appears in the top-right 
corner when the cursor is over the node. To disconnect two nodes, left-click-drag on the input to the connected node 
and move the cursor to either another nodes input or remove the connection by clicking in any open space of the 
diagram. 

 

There are four fundamental node types in the diagram: 

a) b) c) 
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 Hazard: A hazard function describes the exceedance probabilities of various hazard levels. Examples include 
annual maximum peak flow-frequency, peak reservoir pool stage-frequency, and peak ground acceleration. The 
system component is identified and labeled by the selected hazard function. There can be multiple connections 
made to selected hazard function.  

 
 Transform: A transform function can be used to transform (or convert) the hazard levels from one type of function 

to another. The required input to this node is the hazard type to be transformed. The node output is the hazard 
type that the function is transforming into. Multiple connections can be made from a transform function unless it is 
transforming a response function. Multiple transforms can be connected in sequentially. For example, an 
unregulated flow-frequency may need to be transformed into a regulated flow and then transformed again from 
flow to stage to assess probability of failure on hydraulic structures downstream. 
 

 Response: A system response function describes the conditional probability of failure for various hazard levels, 
such as water surface elevations. The failure modes within a system component are identified and labeled by the 
selected response function. There can be multiple failure modes within a system component, each with different 
consequences. The required input is the hazard type that was defined by the selected response function. The 
output type is the same as the input. There can only be one connection from the output. The response function 
also has the option to select if the failure mode is independent of other failure modes within the system 
component. If unchecked, the failure mode will be modeled as perfectly negatively dependent of the other failure 
modes. 

 Consequence: A consequence function describes the consequences of failure or non-failure for various hazard 
levels, such as annual maximum peak water surface elevations. Note that each response node can have a 
different consequence node. Also important, a consequence function connected to the hazard node without a 
response function is considered the non-failure component of the element. A consequence node has one required 
input, the hazard defined by the selected consequence function.  

 

The risk diagram provides the following visual feedback on input data validation: 

A node with no input selected will be highlighted red. 

 A black connection indicates nothing is wrong with the connection, and the units match. But there is not a 
completely connected failure mode or non-failure mode. So, this connection will not be included in the risk 
calculations. 

 A red connection means the connection is not valid. Either the hazard units do not match, or an input hasn’t 
been defined for one of the nodes. The risk analysis cannot be computed if there is an invalid connection. 

 A green connection is for valid failure modes. It indicates that every connection in a system component is 
valid and failure modes are complete. A system component with green connections for the failure modes 
indicates that the component will be included in the risk calculations. 

 A purple connection is for valid non-failure modes. It indicates that every connection in a system component is 
valid and the non-failure mode is complete. A system component with purple connections for the non-failure 
mode indicates that the component will be included in the risk calculations. 

 

Figure 124 shows the risk diagram for a levee risk analysis. The hazard function is a river peak flow-frequency curve. 
Peak flow is transformed to a peak river stage using a flow-to-stage rating curve derived from a hydraulic routing 
model. There is a prior to overtopping failure mode (Prior OT) from backwards erosion piping, and an overtopping 
(OT) failure mode. There are two failure modes shown with green connectors. The non-failure mode is shown at the 
top with the purple connectors. Non-fail consequences are connected directly to the hazard transform function with no 
response function in between.   
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Figure 127 – Example levee risk diagram. 
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Risk Results 
Results of the risk analysis can be viewed in the F-N Plot, α-η Plot, and Summary Statistics tabs (Figure 128). The 
risk results tabs contain results of the risk analysis shown graphically and in tabular form. 

  
Figure 128 – Risk results can be viewed in the F-N Plot, α-η Plot, and Summary Statistics tabs. 

 

F-N Plot 
The F-N plot has consequences (N) on the x-axis and the exceedance probability, or frequency of occurrence, (F) on 
the y-axis [14]. If the hazard function probabilities are defined as an annual frequency, F is an annual exceedance 
probability. This type of plot is also commonly referred to as an F-N curve, survival function, or Farmer diagram. A log-
log scale is typically used because the range of probabilities and consequences can span multiple orders of 
magnitude.  

An example F-N plot is provided below in Figure 129. After simulating risk with full uncertainty, the 90% confidence 
interval is shown as a shaded bound. The mean and median curves are also provided. By default, the USACE 
tolerable risk limit [8] is also plotted. The tolerable risk limit (or guideline) can be customized or removed from the plot. 

 
Figure 129 – Example of F-N plot results with confidence intervals and the USACE tolerable risk limit. 
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Tolerable risk limits (TRL) can be displayed by selecting from the Tolerable Risk Limits dropdown menu (Figure 
129). You can select None, USACE, ANCOLD, or create your own. To add or edit custom limits, press the Edit/Add 
Tolerable Risk Limits button (Figure 130). The tolerable risk limit editor will appear (Figure 131). Finally, the plot 
extents can be automatically set to the selected TRL extents by checking the Set TRL axis extents checkbox. 

  
Figure 130 - Tolerable risk guideline viewing options for graphical risk results in RMC-TotalRisk. 

 

 
Figure 131 - Tolerable risk guideline editor. 
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Each risk result tab has options to filter which results are available. To filter results, click the button  next to Filter 
Results near the top of the risk results tab. Use the checkboxes (Figure 132) to display which risk components and 
types to show in both the graphical and tabular results. Risk components include the overall system risk, all elements 
within the system, and all failure modes within each element. There are 5 types of risk reported in RMC-TotalRisk [1]. 
Each risk type is calculated for a range of probable hazard events. 

• Incremental Risk: The incremental risk of failure of the system. Incremental consequences are the 
incremental losses or damages that failure might inflict over and above any damage which might occur for the 
same event assuming the structure does not fail. The incremental risk is computed with the product of the 
probability of the hazard 𝑃𝑃(𝐻𝐻), the probability of failure given hazard 𝑃𝑃(𝐹𝐹|𝐻𝐻), and the incremental 
consequences from failure (𝐶𝐶∆ = 𝐶𝐶𝐹𝐹 − 𝐶𝐶𝑁𝑁𝑁𝑁). 

• Background Risk: Background risk is defined as the risk of the structure assuming that it has no structural 
flaws or vulnerabilities. In other words, if all the structural vulnerabilities were eliminated, the 
remaining risk would be the background risk from natural hazards. Background risk is computed with the 
product of the probability of the hazard 𝑃𝑃(𝐻𝐻) and the consequences from non-failure (𝐶𝐶𝑁𝑁𝑁𝑁). 

• Total Risk: The overall risk of the system (or component), which is the sum of the failure risk and non-failure 
risk. In some USACE publications, total risk has been referred to as residual risk, i.e., the risk that remains [4] 
[8] [15]. Proper estimation takes into consideration all the potential hazard sources, their likelihoods of 
occurrence, and their potential consequences.  

• Failure Risk: The risk from failure of the system. The failure risk is computed with the product of the 
probability of the hazard 𝑃𝑃(𝐻𝐻), the probability of failure given hazard 𝑃𝑃(𝐹𝐹|𝐻𝐻), and the consequences from 
failure (𝐶𝐶𝐹𝐹). 

• Non-Failure Risk: The risk from non-failure of the system. For infrastructure such as dams and levees, there 
will often be consequences even if the structure does not fail. For example, during a major flood event, a dam 
could activate the emergency spillway, preventing the dam from reducing downstream flooding. The non-
failure risk is computed with the product of the probability of the hazard 𝑃𝑃(𝐻𝐻), the probability of non-failure 
given hazard {1 −  𝑃𝑃(𝐹𝐹|𝐻𝐻)}, and the consequences from non-failure (𝐶𝐶𝑁𝑁𝑁𝑁). 

 

 
Figure 132 - Options to filter what risk results you want to view. Clicking a checkbox will show the results of that component of risk 
in the graphical and tabular risk results. 
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α-η Plot 
Risk results can be viewed with the α-η Plot (pronounced as “alpha-N”), which is a commonly used in the USACE 
dam and levee safety programs for plotting incremental risk. In this plot, the conditional mean consequences (η) are 
plotted on the x-axis and the exceedance probability (α) on the y-axis. Like the F-N plot, a log-log scale is typically 
used because the range of probabilities and consequences can span multiple orders of magnitude. 

In the USACE dam and levee safety programs, this plot has been traditionally called the 𝑓𝑓 ∙ 𝑁𝑁� plot. However, in 
probability and statistics, 𝑓𝑓 is universally used as the symbol for the probability density function, not an exceedance 
probability. Therefore, to avoid any unnecessary confusion and to be consistent with other disciplines, RMC-TotalRisk 
uses 𝛼𝛼 as the symbol for exceedance probability.  

The α-η plot is only available for the risk of failure and incremental risk. Both risk types have the same exceedance 
probability, 𝛼𝛼F = 𝛼𝛼Δ. Total risk and background risk are both unconditional expectations where 𝛼𝛼 = 1.  The risk of non-
failure is a conditional expectation, where 𝛼𝛼𝑁𝑁𝑁𝑁 = 1 − 𝛼𝛼𝐹𝐹. However, 𝛼𝛼𝑁𝑁𝑁𝑁 is typically very close to 1, so there is no 
reason to plot it.  

Figure 133 shows an α-η plot after simulating risk with full uncertainty. The uncertainty is portrayed as a scatter cloud. 
To improve the visibility of this plot, the uncertainty scatter is thinned down to ensure a maximum of 1,000 points per 
system risk component. The mean incremental risk result for the overall system is shown as a red diamond. The 
incremental risk has an exceedance probability 𝛼𝛼Δ = 8.7621𝑒𝑒−6 and conditional mean incremental consequences 
𝜂𝜂Δ = 127.9035. Stated another way, the mean annual probability of failure is 8.7621𝑒𝑒−6, and if the dam were to fail, 
the expected incremental life loss would be 127.9035. The diagonal of the α-η plot is equal to the product of α and η, 
which is the unconditional mean consequences, 𝔼𝔼[N] = 𝛼𝛼 ∙ 𝜂𝜂 = 1.1207𝑒𝑒−3.  

 

Figure 133 – α-η plot displaying incremental risk results as the exceedance probability (α) and conditional mean consequences (η). 
USACE Tolerable Risk Limits are being shown in the plot. 
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Summary Statistics 
The Summary Statistics tab displays result statistics for each of the filtered risk measures (Figure 134). Each column 
in the table is explained below: 

• Component: The overall system, the individual system components, and each failure mode within each 
system component. The overall system is labelled by the name of the risk analysis. The system components 
are labelled by the name of the selected hazard function. The failure modes are labelled by the hazard 
function and the selected response function.  

• Risk Type: There are 5 types of risk reported in RMC-TotalRisk: Incremental, Background, Total, Failure, and 
Non-Failure.  
 

• Exceedance Probability, α: The exceedance probability of system failure. This probability is 1 for 
Background Risk and TotalRisk. For Non-Fail Risk, this is 1 minus the failure probability, which is often very 
close to 1.  

• Conditional Mean, η: The mean (or expected) consequences given system failure. The product of the 
exceedance probability (α) and the condition mean (η) is equal to the unconditional mean, E[N] = α ∙ η. This 
measure is applicable for Incremental and Failure Risk where the probability of failure is explicitly considered. 

• Mean, E[N]: The mean (or expected) consequences are a probability weighted average over all hazardous 
events. In flood damage assessments this term is commonly called Expected Annual Damage (EAD). 

• Standard Deviation, σ: The standard deviation of the consequences N. This provides a measure of deviation 
from the mean, E[N]. If two alternatives have the same mean, E[N], the one with the smaller standard 
deviation is considered less risky. 

 
Figure 134 - Summary statistics from a risk analysis - risk results in RMC-TotalRisk. 
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Diagnostics 
RMC-TotalRisk provides several diagnostics for exploring the Monte Carlo simulation results for a risk analysis. If no 
uncertainty has been defined in the risk analysis inputs, the diagnostic tools provide limited value. The following 
subsections describe the available risk analysis diagnostics.  

Integration 
The integration diagnostics include an estimate of the standard error of the computed total risk for the system, and the 
number of integrand function evaluations performed during the risk simulation. The diagnostics are graphically 
displayed as a kernel density or cumulative distribution plot. Summary statistics, including the mean, standard 
deviation, and key percentiles are provided in a table. Figure 135 shows an example of the integration diagnostics for 
the number of function evaluations performed during the simulation. For this example, 121 function evaluations were 
performed on average for each Monte Carlo realizations.  

 
Figure 135 - Example of integration diagnostics. 
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Risk Measures 
RMC-TotalRisk computes six risk measures for all five risk types:  

• Exceedance Probability, α: The exceedance probability of system failure. This probability is 1 for 
Background Risk and TotalRisk. For Non-Fail Risk, this is 1 minus the failure probability, which is often very 
close to 1.  

• Conditional Mean, η: The mean (or expected) consequences given system failure. The product of the 
exceedance probability (α) and the condition mean (η) is equal to the unconditional mean, E[N] = α ∙ η. This 
measure is applicable for Incremental and Failure Risk where the probability of failure is explicitly considered. 

• Mean, E[N]: The mean (or expected) consequences are a probability weighted average over all hazardous 
events. In flood damage assessments this term is commonly called Expected Annual Damage (EAD). 

• Standard Deviation, σ: The standard deviation of the consequences N. This provides a measure of deviation 
from the mean, E[N]. If two alternatives have the same mean, E[N], the one with the smaller standard 
deviation is considered less risky. 

• Consequence Threshold Probability: The probability that the user-specified consequence threshold will be 
exceeded. 

• Value-at-Risk (VaR): A risk measure that estimates the minimum consequences for a user-specified 
exceedance probability (α). 
 

• Conditional Value-at-Risk (CVaR): A risk measure that estimates the conditional mean (or expected) 
consequences for a user-specified exceedance probability (α). 

Please see the technical reference manual [1] for mathematical details on these risk measures.  

As shown in Figure 136, select the desired Risk Type and the Risk Measure from the dropdowns to view the results. 
You can view the distribution as a Kernel Density or as a Cumulative Distribution using the radio buttons at the 
bottom of the plot (Figure 137). Summary statistics of the distribution are displayed in the upper right-hand corner 
(Figure 137). 

 
Figure 136 - Select the risk type and risk measure to display results. 
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Figure 137 - Risk measure diagnostic tools in RMC-TotalRisk showing the kernel density of the Incremental Conditional Value-at-
Risk (CVaR). 
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Risk Profile 
A risk profile plots the exceedance probabilities or conditional mean consequences against increasing hazard levels. 
The risk profile results can be filtered by System Component and Risk Type. This plot is useful for identifying critical 
hazard levels where the probability of failure or risk sharply increases. Figure 138 shows the hazard exceedance 
probability for the background risk of Dam A. Since background risk represents the remaining risk from the natural 
hazard, this risk profile will match the input reservoir stage-frequency hazard function.  

 
Figure 138 - Example of a risk profile plot showing the hazard exceedance probability for the background risk at Dam A. 

 

Figure 139 below shows the hazard exceedance probability for the incremental risk at Dam A. There is an inflection 
point in the profile near a reservoir stage of 595 ft. The is because PFM 1 (spillway erosion) has a non-zero probability 
of failure beginning near this hazard level. This is the point where incremental risk will begin to occur.   DRAFT
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Figure 139 - Example of a risk profile plot showing the hazard exceedance probability for the incremental risk at Dam A. 
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Assurance 
An assurance plot and summary statistics are provided based on a user-defined profile hazard type and hazard 
threshold. This diagnostic is intended to support the National Flood Insurance Program for levees. Please see the 
technical reference for more details [1].  

Figure 140 below shows an example risk diagram for a levee risk analysis. The primary hazard is river peak flow-
frequency. Peak flow is transformed to a peak river stage using a flow-to-stage rating curve derived from a hydraulic 
routing model. There is a prior to overtopping failure mode (Prior OT) from backwards erosion piping, and an 
overtopping (OT) failure mode. The top of levee is at a river stage of 65 ft.  

 
Figure 140 - Example risk diagram for a levee risk analysis. 

 

To compute the assurance, the user must select the Profile Hazard Type and specify the Hazard Threshold for the 
desired system component in the risk analysis options as shown in Figure 141: 

• Profile Hazard Type: The hazard type used for constructing risk profiles and used for estimating the 
probability of exceeding the hazard threshold. For a levee accreditation analysis, the hazard type should be 
stage or water surface elevation.  
 

• Hazard Threshold: The probability of hazard levels exceeding the threshold will be recorded in the risk 
simulation. For a levee accreditation analysis, the hazard threshold should be the top of levee height or 
elevation. 
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Figure 141 - Setting the profile hazard type and threshold level for the system component. 

 

The assurance diagnostic estimates the uncertainty in the annual probability of inundation (API). The level of 
assurance (e.g., the levee can be accredited with 85% assurance) is synonymous with the confidence level, i.e., the 
leveed area is inundated with a probability of 0.01 or less, with 85% confidence. To assess the level of assurance with 
RMC-TotalRisk, the risk analysis must be simulated with full uncertainty. 

After the risk analysis is complete, the user can navigate to the Diagnostics tab, and then the Assurance tab. Figure 
142 shows the standard cumulative distribution plot for assurance. The API is on the x-axis, and the non-exceedance 
probability of the uncertainty in the API is on the y-axis. For this example, the mean API is shown as a vertical, 
dashed blue line at 0.00643. The target level of 0.01 (100-yr), which is shown as a vertical orange line, is shown to 
have an assurance level of 84.6%.  

If the assurance level is less than 65%, the target level line will be plotted as a vertical red line. If the assurance is 
between 65% and 85%, the target level line will be plotted as an orange line. If the assurance is greater than 85%, it 
will be plotted as a greed line. In the example below, the assurance of containing the 0.01 AEP event falls between 
65% and 85%. Therefore, the levee accreditation recommendation must be supported based on uncertainty, past 
system performance, and other factors [16]. 

 
Figure 142 - Example of the cumulative distribution plot for NFIP assurance. 
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Tornado Plot 
A tornado plot (Figure 143) is provided so you can visually assess how sensitive the risk results are to the input 
functions at each hazard level. The tornado plot is constructed based on the selected System Component, Risk 
Type, Sensitivity Measure, and Hazard Level. The inputs are ranked from most sensitive at the top to least sensitive 
at the bottom. The sensitivity measure options are Sensitivity Index, Pearson’s Correlation, and Spearman’s 
Correlation [1]. The risk sensitivity will typically vary with the hazard level. For example, at low hazard levels, the risk 
results might be most sensitive to the uncertainty in response, whereas at higher hazard levels, the results are more 
sensitive to the uncertainty in the hazard probability. Change the hazard level to see how the component sensitivity 
changes as hazard goes from low to high. 

 

 
Figure 143 - Example of a tornado plot for risk diagnostics. 
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X-Y Plot 
The X-Y plot (Figure 144) is provided to assess the correlation between the different system risk components and 
inputs. Results can be filtered by the Risk Type, Risk Measure, X Parameter, and Y Parameter components. For 
example, the overall risk of failure at the dam could be the Y parameter, and the risk of failure from an individual 
failure mode could be the X parameter. As shown below, the incremental risk of failure mode PFM 2 (concentrated 
leak erosion) is very strongly correlated to the incremental risk of the overall system. This means that large changes 
to the PFM 2 failure mode will be associated with large changes in the overall system risk. These results align with the 
sensitivity results shown in Figure 143. 

 
Figure 144 - Example of a X-Y plot for risk diagnostics. 
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Tabular 
Tabular results are provided based on the selected Risk Type and Risk Measure (Figure 145). The table has a 
column for each system component and a row for each Monte Carlo realization. The data in this table can be 
exported, copied, or analyzed using the table column tools.  

 
Figure 145 - Tabular diagnostics tab displays every Monte Carlo realization for the selected risk type and risk measure. 
 

Select a column of interest and right-click on the column header. Then, left-click on the Summary Statistics… option. 
A histogram plot and detailed summary statistics will be calculated for the selected column as shown in Figure 146 
below.  DRAFT
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Figure 146 - Example of the histogram and summary statistics output for tabular results. 
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